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Getting Started with Kidspiration

A visual learning tool for students K-3

Kidspiration™ helps K-3 students see, organize, and develop their
great ideas. Using the proven principles of visual learning, kids
build their confidence in creating stories, organizing information,
understanding concepts and expressing and sharing their thoughts.

Picture view provides a simple, friendly interface that lets kids use
symbols to represent ideas and concepts. The Kidspiration symbol
libraries offer more than 1,200 images designed specifically for
kids in kindergarten through third grade. Symbols make it simple to
create and use graphical organizers, webs, concept maps and other
visual learning diagrams.

Writing view integrates with Picture view to help students connect
their visual thoughts with words. From the thought webs and maps
they create in Picture view, students can expand their ideas into
written thoughts.

Audio gives students the chance to hear their work read aloud or
even record their own words. All menus, buttons, and text in
Kidspiration are supported by audio so emerging readers can use
the product by themselves.

Over 45 student activities designed to K-3 standards make getting
started with Kidspiration in your classroom a snap. Activities focus
on reading and writing, science, social studies, and more. You can
also create your own activities using the Activity Wizard, which
steps you through the process of creating a new activity or
modifying an existing activity.

This User’s Guide is a complete reference to using Kidspiration
successfully in your classroom. The information in this User’s
Guide is also available in the online Help system.
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View or print the Kidspiration User’s Guide on the
CD-ROM

So you can print additional copies of this User’s Guide, an Acrobat
file named User’s Guide.PDF is included in the User’s Guide
folder on the Kidspiration CD-ROM.

To view or print the guide:

1 Install Acrobat Reader if necessary (see below).

2 Insert the Kidspiration CD-ROM into your CD-ROM drive.

3 Double-click the User’s Guide folder on the CD-ROM to open
it, and then double-click User’s Guide.PDF to view or print
the guide.

To install Acrobat Reader:

1 Close all programs including screen saver and anti-virus
programs.

2 Insert the Kidspiration CD-ROM into your CD-ROM drive.

3 Double-click the User’s Guide folder on the CD-ROM to open
it, and then double-click the Reader Installer icon
(Macintosh®) or Acrobat.exe icon (Windows®). Follow the
instructions on the screen.

Technical support

If you have comments, questions or need help using Kidspiration,
contact Inspiration Software Technical Support by telephone, fax
or e-mail. When you contact us, please be ready to provide the
serial number for your software.

Telephone (503) 297-3004
Monday–Friday
8 a.m. to 5 p.m. Pacific Time

Fax (503) 297-4676

E-mail techsupport@inspiration.com
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Hardware and software requirements

Kidspiration requires certain hardware and software components to
run. To use Kidspiration, you need:

Macintosh computers

♦  Macintosh or Power Macintosh

♦  System 7.1, 8.0, 9.0 or later Macintosh operating system

♦  5 MB of available hard disk space; 30 MB for full install that
includes all symbol libraries

♦  2 MB of memory (RAM)

♦  640 x 480, 256-color display or higher

♦  CD-ROM drive for installation

Optional hardware and software for Macintosh
computers

♦  Internet account and Web browser to use the Internet features

♦  Macintosh-compatible printer

♦  Microphone to use the audio features

Computers running Windows

♦  486 processor or higher

♦  Windows 95, Windows 98, Windows 2000, Windows ME or
Windows NT® 4.0

♦  5 MB of available hard disk space; 20 MB for full install that
includes all symbol libraries

♦  8 MB of memory (RAM)
♦  640 x 480, 256-color display or higher

♦  CD-ROM drive for installation
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Optional hardware and software for computers running
Windows

♦  Internet account and Web browser to use the Internet features

♦  Windows-compatible printer

♦  Soundcard and speakers

♦  Microphone to use the audio features

Install Kidspiration

Macintosh  installation

1 Close all programs including screen saver and anti-virus
programs.

2 Insert the Kidspiration CD-ROM into your CD-ROM drive.

3 Double-click the icon for your CD-ROM drive, and then
double-click the Kidspiration Install icon to install
Kidspiration.

If necessary, the installer will ask to add the required text-to-
speech software to your computer. Click OK to install. After
updating the computer’s system software, your computer will
restart and automatically continue the Kidspiration installation.

4 On the drop-down menu, select Easy Install or Custom
Install:

♦ Select Easy Install to install the full Kidspiration program,
including symbols, activities, examples, and online Help.
–or–

♦ Select Custom Install to selectively install Kidspiration
program components. Choose this option if you have
limited hard disk space and you do not want to install the
full Kidspiration program.

5 Click Quit when installation is complete.

6 Kidspiration starts automatically. To register your copy of
Kidspiration, follow the instructions on the screen.
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Windows installation

1 Close all programs including screen saver and anti-virus
programs.

2 Insert the Kidspiration CD-ROM into your CD-ROM drive.

3 Double-click My Computer, and then double-click the icon
for your CD-ROM drive.

4 Double-click the Install.exe icon to install Kidspiration.

If necessary, the installer will ask to add the required text-to-
speech software to your computer. Click OK to install. After
updating the computer’s system software, your computer will
restart and automatically continue the Kidspiration installation.

5 Select Easy Install or Custom Install:

♦ Select Easy Install to install the full Kidspiration program,
including symbols, activities, examples, and online Help.
–or–

♦ Select Custom Install to selectively install Kidspiration
program components. Choose this option if you have
limited hard disk space and you do not want to install the
full Kidspiration program.

6 Click Quit when installation is complete.

7 Kidspiration starts automatically. To register your copy of
Kidspiration, follow the instructions on the screen.

Network installation

Refer to the network installation instructions provided with your
volume license. Volume licenses are available from Inspiration
Software, Inc. For more information, call (503) 297-3004.



Kidspiration User’s Guide12

Register Kidspiration

When you register you are entitled to special benefits, including:

♦  Telephone, fax, and e-mail technical support

♦  Discounts on Kidspiration upgrades

♦  Tips on using Kidspiration

♦  Information about new products and product updates

♦  Inspiration Software newsletter

If you purchased a single copy of Kidspiration, there are two ways
to register:

♦  Online—after you install the program, simply follow the
instructions on the screen.

–or–

♦  By mail—send in the printed registration card provided.

To register a volume license, please send in the printed license
agreement.

Remove Kidspiration

Macintosh

♦ Drag the Kidspiration folder to the Trash, and then empty the
Trash.

Windows

1 Click the Start button, point to Settings, and then click
Control Panel.

2 Double-click Add/Remove Programs.

3 Select Kidspiration in the list box, and then click
Add/Remove.
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Start and close Kidspiration

Start Kidspiration

Macintosh

♦ Open the Kidspiration folder, and then double-click the
Kidspiration icon.

Windows

♦ Click the Start button, point to Programs, and then click
Kidspiration.

Close Kidspiration

♦ On the File menu, click Quit (Macintosh) or Exit (Windows).

About the Kidspiration views

About Picture view

In Picture view (see next page), Kidspiration gives you many
different tools to map, organize, and display ideas visually.

The buttons on the Picture toolbar provide easy access to the key
features of the program. Point at a button on the toolbar to see and
hear a brief description of the button’s purpose. Click a button to
carry out the function.

The Symbol palette includes hundreds of symbols that you can use
to show your ideas visually. Point at a symbol to see a magnified
preview. To place a symbol on your diagram, drag the symbol from
the Symbol palette.

The First Idea symbol provides a starting point for your diagram.
Type text into the First Idea symbol or change it to a symbol that
represents your idea.
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Use the tools on the Formatting toolbar to change the look of the
text, symbols, and links on your diagram.

To return to the Kidspiration Starter at any time, click the
Kidspiration Guide. You will be prompted to save the open
project.

Kidspiration Guide Picture toolbar

First Idea symbol

Symbol palette

Formatting toolbar
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Toolbar buttons in Picture view

Click this button… …to do this

Go to Writing view.

Add a connected or unconnected symbol
to your diagram.

Link symbols on your diagram.

Add a SuperGrouper™ category to your
diagram or change a SuperGrouper
shape.

Clear the current selection (symbol, link,
SuperGrouper category or text) from
your diagram.

Undo the last change that you made.

Turn on the Listen tool. Click a symbol,
link or SuperGrouper category to hear
the computer read the text in the
selection.

Print your name and additional classroom
information at the top of the page.
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The Symbol palette

Kidspiration has over 1,200 symbols to choose from. The symbols
are organized into libraries to help you find the symbol that you
want.

To choose a symbol on the Symbol palette:

1 Click the Pick Library button , and then click the category
of symbols that you want to view, for example “School.”

2 Click the Next Library buttons   to move between the
symbol libraries.

Click to choose a symbol category.

Click to see the next library.Click to see the
previous library.

To see a preview of a symbol, point to it.
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Formatting toolbar in Picture view

When you change the look of a symbol or link, the change you
make applies not only to that symbol, but also to new symbols and
links that you add to your diagram from that point on. For example,
if you select a basic symbol shape such as an oval or rectangle, and
you change its colors to yellow and black, any basic symbols that
you add to your diagram will also be yellow and black. New
symbols and links are not affected by changes to selected text
within symbols and links.

Click this button… …to do this

Change the font of the selected text,
symbol or link.

Change the text size of the selected text,
symbol or link.

Apply bold formatting to the selected
text, symbol or link.

Apply italic formatting to the selected
text, symbol or link.

Underline the words in the selected text,
symbol, or link.

Change the color of the words in the
selected symbol or link.

Change the arrowhead style for the
selected link.

Change the line thickness of the selected
symbol or link.

Change the colors of the selected symbol.
Note…The colors that appear on the
Formatting toolbar are the colors in the
selected symbol.
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About Writing view

In Writing view, Kidspiration gives you many different tools for
organizing and expanding your ideas in writing.

The buttons on the Writing toolbar provide easy access to
Kidspiration features. Point at a button on the toolbar to see and
hear a brief description of the button’s purpose. Click a button to
carry out the function.

The First Idea provides a starting point for your writing. Type an
idea in the First Idea and go from there.

Use the tools on the Formatting toolbar to change the look of the
text and the page.

To return to the Kidspiration Starter at any time, click the
Kidspiration Guide. You will be prompted to save the open
project.

Kidspiration Guide

Writing toolbar First Idea

Formatting toolbar
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Toolbar buttons in Writing view

Click this button… …to do this

Go to Picture view.

Add an idea to your project.

Move the selected idea up a level in the
hierarchy.

Move the selected idea down a level in
the hierarchy.

Clear the selected text or idea from your
project.

Undo the last change that you made.

Turn on the Listen tool. Click an idea to
hear the computer read it.

Print your name and additional classroom
information at the top of the page or add
page numbers to the bottom of the page.
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Formatting toolbar in Writing view

When you change the look of an idea, the change you make applies
to new ideas that you add to your writing project. For example, if
you select an idea, and change its text color to green, any ideas that
you add to your writing project will also have green text. New
ideas are not affected by changes to selected text within an idea.

Click this button… …to do this

Choose the font of the selected text or
idea.

Choose the font size of the selected text
or idea.

Make the words in the selected text or
idea bold.

Make the words in the selected text or
idea italic.

Underline the words in the selected text
or idea.

Change the color of the words in the
selected text or idea.

Change the prefix style.

Show or hide the lined paper.
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Learning Kidspiration, A Tutorial

This section of the User’s Guide is a tutorial that introduces basic
Kidspiration diagram and writing tools.

In Picture view, you use symbols to show your ideas. You use links
or SuperGrouper categories to show how these ideas flow and
connect. Writing view integrates with Picture view to connect your
visual ideas with words. From thought webs and maps, you can
expand your ideas into written expression.

In the first lesson, you will create a diagram using symbols, words,
and links. In the second lesson, you will work with the ideas you
started as a diagram in writing. In the third lesson, you will create
two SuperGrouper categories and use them to categorize ideas. In
the fourth lesson, you will print and close your project. The tutorial
takes about 20 minutes from start to finish.

When you are finished with the tutorial, you will be ready to create
your own diagrams and writing projects using Kidspiration.
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Lesson 1: Create a diagram in Picture view

In this lesson you will create a diagram called “All About Me”
using symbols, words, and links. You will learn to do the
following:

♦  Start Kidspiration

♦  Start a new diagram

♦  Save your work

♦  Add symbols to your diagram

♦  Use the Symbol palette

♦  Move symbols

♦  Connect symbols using links

♦  Listen to the ideas in your diagram

♦  Record your own words or sounds

♦  Switch to Writing view

Start Kidspiration

Macintosh

♦ Open the Kidspiration folder, and then double-click the
Kidspiration icon. The Kidspiration Starter opens.

Windows

♦ Click the Start button, point to Programs, and then click
Kidspiration. The Kidspiration starter opens.

The Kidspiration Starter is the place where you can start new
projects, open existing projects, and use the many different
Kidspiration activities. We’ll begin by starting a new diagram.

To start Kidspiration, click the Kidspiration icon.
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Start a new diagram

1 To start a new diagram, click the Picture button.

2 The First Idea provides a starting point for your work. In the
First Idea symbol, type All About Me. Your diagram should
look like this:

Save your work

You should save your work often so you don’t lose any changes if
the computer quits unexpectedly. The first time you save, you type
a name for your project.

1 On the File menu, click Save.

2 In the folder list, select the folder where you want to save the
project.

3 Type a name for the project, and then click Save.

Kidspiration suggests a name based on your First Idea, but you
can use a different name.

To start a new diagram, click
the Picture button.

To add text to a symbol, select the
symbol, and then type.
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Add symbols to your diagram

1 Click the All About Me symbol to select it.

2 To add two symbols that are connected to the All About Me
symbol, click the Add Symbol button twice.

Now, your diagram should look like this:

3 Click one of the new symbols to select it, and then type the
word pets.

4 Click the other symbol to select it, and then type the word
sports.

Your diagram should look like this:

To add linked symbols to a selected
symbol, click the Add Symbol button.

To select a symbol, click it.
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Use the Symbol palette

Now, let’s use the Symbol palette to add more symbols to your
diagram. The Symbol palette has hundreds of symbols that you can
use to show your ideas. Here’s the Symbol palette:

1 On the Symbol palette, click the Pick Library button , and
then click Animals and Plants.

2 Click the Next Library button  until you see the kitten
symbol, and then drag the kitten symbol onto your diagram.

3 On the Symbol palette, click the Pick Library button , and
then click School.

4 Click the Next Library button  until you see the symbol
library that has the soccer symbol.

5 Drag the soccer symbol onto your diagram.

To see a preview of a symbol, point to it.

Click to choose a symbol category.

Click to see the next library.Click to see the
previous library.



Kidspiration User’s Guide26

Now, your diagram looks something like this:

Move symbols

♦ In Kidspiration you can always move symbols. When you do,
any links will be automatically adjusted. Move the kitten
symbol and the soccer symbol so your diagram looks like the
one below. To move a symbol, select it, and then drag it to the
new location.
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Connect symbols using links

Now, we are going to use a link to connect the pets symbol to the
kitten symbol. And, we are going to connect the sports symbol to
the soccer symbol.

1 Click the pets symbol to select it.

2 Click the Link Symbols button to turn it on.

3 Click the kitten symbol to create a link to it.

4 Click the sports symbol to select it.

5 Click the soccer symbol to create a link to it.

6 Click the Link Symbols button to turn it off.

Now your diagram looks like this:

To link symbols in a diagram,
click the Link Symbols button.
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Listen to the ideas in your diagram

You can use the computer to read the ideas in your diagram.

1 To turn on the Listen tool, click the Listen button.

2 To hear the computer read an idea in your diagram, click the
pets symbol.

3 Now, click the sports symbol to read the word.

4 To turn off the Listen tool, click the Listen button again.

Record your own words or sounds

To support emerging readers, you can record words or sounds and
attach them to a symbol. Let’s record a sentence and attach it to the
kitten symbol.

1 Click the kitten symbol to select it.

2 On the Sound menu, click Record.

To listen to the ideas in your
diagram, click the Listen button.
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3 To begin recording, click the Record button.

4 Say My kitten’s name is Mr. Jones. When you are finished
recording the sound, click Save.

6 To play the recording, click the speaker  in the upper right
corner of the kitten symbol.

Clear part of your diagram

Here’s a quick way to clear a part of your diagram.

1 Drag the surfing symbol onto your diagram. It will be selected.

2 To erase the symbol, click the Clear button.

Fix a mistake

Here’s a quick way to fix something you didn’t mean to do.

♦ To undo what you just did, click the Undo button.

To clear a part of your diagram,
click the Clear button.

To undo what you just did,
click the Undo button.

To begin recording, click Record.

To save the recording and attach
it to the symbol, click Save.
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Change the look of symbols using color

You can use color to customize the look of your symbols. You can
change the colors of two-color symbols and multicolor symbols.
Let’s change the colors of the pets symbol, and then change the
colors of the soccer symbol.

1 Click the pets symbol to select it.

The Symbol Colors tool appears on the Formatting toolbar.

2 On the Symbol Colors tool, click the color that you want to
change, and then click a new color on the color menu.

3 Click the soccer symbol to select it.

You can change any color that appears in a multicolor symbol.

4 On the Symbol Colors tool, click the color that you want to
change, and then click a new color on the color menu.

Save your work

Remember to save your work!

1 To save your work, click Save on the File menu.

2 In the Save dialog box, click Save.

Each time you save you are prompted to replace the existing
file. Click Replace to save your file.

Click the color that you want to change on the
Symbol Colors tool, and then click a new color.
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Lesson 2: Work with ideas in Writing view

In this lesson you will open the diagram you created in the previous
lesson and work with it in Writing view. You will learn to do the
following:

♦  Switch to Writing view

♦  Add ideas

♦  Move an idea

♦  Add details to an idea

♦  Change the look of ideas using the Formatting toolbar

♦  Change the prefix style

♦  Switch to Picture view

Switch to Writing view

While you’ve been working in Picture view, Kidspiration has been
building a written project using the ideas in your diagram.

♦ To view your diagram in Writing view, click the Go to
Writing button.

To view your picture in writing,
click the Go to Writing button.
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In Writing view, the ideas in your diagram are organized from top
to bottom with your first idea—All About Me—at the top.

The kitten and soccer words have been added automatically by the
Picture-to-Topic option, which helps emerging readers and writers
make connections between symbols and words. For more
information about the Picture-to-Topic option, see “Use the ideas in
a diagram to begin writing” in “Working in Writing View” later in
this guide. Sounds recorded in Picture view are also available in
Writing view.
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Add an idea

Now we are going to add an idea to your writing project.

1 Click the All About Me idea to select it.

2 To add the new idea, click the Add Idea button.

3 Type the word family in the new idea.

This is what your project looks like now:

To add a new idea to a writing project,
click the Add Idea button.
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Move an idea

Now we want to move the family idea up so it is just below the All
About Me idea.

♦ Drag the family idea up so it is located below the All About Me
idea.

To move an idea, click the left side of the idea. When the
grabber hand  appears, drag the idea to the new location.

This is what your writing project looks like now:

To move an idea, select it, and then
drag it to the new location.
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Add details to an idea

Notes are a great way to add more information about an idea. You
can add as many lines of notes as you wish.

1 Click below the top line in the family idea to add details.

2 Type I have two sisters.

Change the look of ideas using the Formatting
tools

You can change the look of ideas using color, font, and text size.
We are going to change the color, font, and text size of the All
About Me idea.

1 Click the All About Me idea to select it.

2 To change the color of the text, click the Text Color button

, and then click a color that you like.

3 Click the arrows on the Font box until you see a font that you
like.

4 To increase the text size, click the up arrow on the Text Size
box to increase the text size to 18.

Click in the notes area of an idea,
and then type to add details.

To increase or decrease text size, click the
arrows on the Text Size box.

To change the font, click the
arrows on the Font box.
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Change the prefix style

For advanced students, Writing view can be used as an outliner.
The prefix style is the type of letters, numbers, or bullets that mark
each idea in a writing project. Let’s change the prefix style to
Letters and Numbers.

♦ On the Formatting toolbar, click the Prefix button  until the
All About Me idea is preceded by the letter “A”, and the
second-level ideas are preceded by a number. This is what your
writing project looks like now.
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Switch to Picture view

While you’ve been working in Writing view, Kidspiration has been
adding symbols to your diagram to represent the ideas you added in
Writing view.

♦ To view your writing project in Picture view, click the Go to
Pictures button.

This is what your diagram looks like now:

To view a writing project in Picture view,
click the Go to Pictures button.
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Close your project and return to the
Kidspiration Starter

♦ To close your project and return to the Kidspiration Starter,
click the Kidspiration Guide.

When you return to the Kidspiration Starter, you are prompted
to save the open project.

To return to the Kidspiration Starter,
click the Kidspiration Guide.
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Lesson 3: Categorize ideas using the
SuperGrouper tool

In Kidspiration there are two basic ways to organize ideas in
Picture view—links and SuperGrouper categories. We’ve already
seen how links work. Let’s take a look at the SuperGrouper tool.

Categorizing and sorting are important skills for K-3 students, and
the SuperGrouper tool makes these activities easy and fun. In many
cases, teachers will find it most effective to create the
SuperGrouper categories as part of an activity and let students
simply arrange ideas into the respective category. In this lesson,
you will learn to do the following:

♦  Start a new diagram

♦  Add a SuperGrouper category

♦  Add a title to a SuperGrouper category

♦  Change the size of a SuperGrouper category

♦  Change the colors of a SuperGrouper category
♦  Add symbols to a SuperGrouper category

♦  Remove a symbol from a SuperGrouper category

♦  View a SuperGrouper diagram in Writing view

Start a new diagram

1 To start a new diagram, click the Picture button.

A new diagram opens with the First Idea symbol selected.

To start a new diagram,
click the Picture button.
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Save your work

The first time you save, you type a name for your project.

1 On the File menu, click Save.

2 In the folder list, select the folder where you want to save the
project.

3 Type a name for the project, and then click Save.

Add a SuperGrouper category

1 On the Picture toolbar, click the SuperGrouper button, and
then click the outside SuperGrouper shape to add it to your
diagram.

The new SuperGrouper category automatically contains any
selected symbols—in this example, the First Idea symbol—on
the diagram.

2 To create a title for the diagram, drag the First Idea symbol to
the top of the page and type the words Sea and Land inside the
symbol.

To add a SuperGrouper category, click the
SuperGrouper button…

…and then click the SuperGrouper
shape that you want.
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Now your diagram looks like this:

2 Click the background of the diagram so the first SuperGrouper
category is not selected.

3 Add a second SuperGrouper category to your diagram just like
the first one so you have two outside SuperGrouper shapes side
by side.

4 Adjust the position of each SuperGrouper category by
dragging it.

Add a title to a SuperGrouper category

Now, let’s add a title to each SuperGrouper category.

1 To add a title to the first SuperGrouper category, select it, and
then type Things that live in the ocean.

2 Now add a title to the second SuperGrouper category. Select
the second SuperGrouper category, and then type Things that
live on land.
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Now your diagram looks like this:

Change the size of a SuperGrouper category

Now, let’s increase the size of the Things that live in the ocean
SuperGrouper category so the title fits better across the top.

♦ To resize a SuperGrouper category proportionally, select it, and
then drag the lower right resize handle until the SuperGrouper
category is the size that you want. Use the marquee—the dotted
outline—which appears to get the size that you want.
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Change the colors of a SuperGrouper category

Now let’s change the green colors of the Things that live in the
ocean SuperGrouper category to shades of blue to go with the title.

1 Select the Things that live in the ocean SuperGrouper category.

The Symbol Colors tool appears on the Formatting toolbar. On
the Symbol Colors tool, click the color that you want to
change, and then click a new color on the color menu.

2 Change the green colors in the SuperGrouper category to
shades of blue that are darker than the light blue sky.

Add symbols to a SuperGrouper category

Now, we are ready to add symbols to each SuperGrouper category.
The easiest way to do this is to drag symbols from the Symbol
palette.

1 Click the Pick Library  button, and then click Animals and
Plants.

2 Click the Next Library button  until you see a library that
contains sea creature symbols.

3 Drag the dolphin symbol to the Things that live in the ocean
SuperGrouper category.

4 Drag the stingray symbol to the SuperGrouper category.

5 Drag the starfish symbol to the SuperGrouper category.

On the Symbol Colors tool, click the color that you want to
change, and then click a new color on the color menu.
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Now, the Things that live in the ocean SuperGrouper category
looks something like this:

Now let’s add symbols to The things that live on land
SuperGrouper category.

1 Click the Next Library button  until you see the library that
contains farm animals.

2 Drag the horse symbol to the SuperGrouper category.

3 Drag the chicken symbol to the SuperGrouper category.

4 Drag the pig symbol to the SuperGrouper category.
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Now, your diagram looks something like this:

Remove a symbol from a SuperGrouper
category

♦ To remove a symbol from a SuperGrouper category, drag the
symbol to another location.

–or–

To delete the symbol, select it, and then click the Clear button.

 

View a SuperGrouper diagram in Writing view

♦ To view the SuperGrouper categories in Writing view, click the
Go to Writing button.

To delete a symbol from a SuperGrouper category,
select the symbol, and then click the Clear button.

To view a SuperGrouper diagram in Writing view,
click the Go to Writing button.
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This is what the SuperGrouper categories look like in Writing
view:

The titles of the SuperGrouper categories assume a top-level
position, and the symbols that each SuperGrouper category
contains are supporting ideas. Any changes you make here will be
reflected in Picture view.
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Lesson 4: Print your work and close your project

In this lesson, you will return to Picture view and print your
project. You will learn how to do the following:

♦  Switch to Picture view

♦  Add your name to the top of the page for printing

♦  Print your work

♦  Close your document

Switch to Picture view

♦ To view the SuperGrouper categories in Picture view, click the
Go to Pictures button.

Add your name to the top of the page for
printing

You can add your name and other information such as your teacher
and classroom number to your project. When you print your work,
your name appears at the top of the page.

1 To add your name to your project, click the Student Name
button.

2 Type your name and other information in the box where you
want the information to appear.

For example, if you type your name in the Left box, your name
will appear in the upper left corner of the page.

To view a writing project in Picture view,
click the Go to Pictures button.

To add your name to your project,
click the Student Name button.
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Print your work

Now you are ready to print your work.

1 To print your work, click Print on the File menu.

2 In the Print dialog box, click Print.

Close your project and return to the
Kidspiration Starter

♦ To close your project and return to the Kidspiration Starter,
click the Kidspiration Guide.

When you return to the Kidspiration Starter, you are prompted
to save any open documents.

Congratulations! You’ve finished the Kidspiration tutorial.

To return to the Kidspiration Starter,
click the Kidspiration Guide.
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Opening, Closing, and Saving Projects

Start a new Kidspiration project

1 Start Kidspiration.

–or–

To return to the Kidspiration Starter from an open project, click
the Kidspiration Guide:

2 Do one of the following:

♦ To start with a diagram, click the Picture button.

–or–

♦ To start with words, click the Writing button.
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Open a Kidspiration activity

1 Start Kidspiration.

–or–

On the File menu, click New.

2 Under Activities, click a category, for example “Science.”

3 Select an activity from the list, and then double-click it to
open it.

To open an activity, click a category, and
then select from the activities listed.
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Open an existing project

1 On the File menu, click Open.

–or–

From the Kidspiration Starter, click the Open File button:

2 Open the folder where the file is located.

3 Double-click the file in the list box.

Save a project

You should save your work frequently to prevent losing any
changes if the computer quits unexpectedly.

To save a project:

1 On the File menu, click Save to save the latest changes to your
work.

The first time you save, select the folder where you want to
save the project and type a name for the project.

2 In the Save dialog box, click Save.

Each time you save a project, you are prompted to replace the
existing file. Click Replace to save the project.
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Save a project under a different name

1 On the File menu, click Save.

2 Select the folder where you want to save the project.

3 Type a new name for the project, and then click Save.

Open a file created in another program

Kidspiration can open the following types of files:

♦  Inspiration® 6 files (Macintosh or Windows)

When you open an Inspiration 6 file in Kidspiration, you may
lose some elements of the Inspiration file. For more
information, see “Open an Inspiration file” later in this section.
In Windows, the Inspiration file must have the INS extension.

♦  Kidspiration files (Macintosh or Windows)

In Windows, Kidspiration files must have the KID extension.

To open a file created in another program:

1 On the File menu, click Open.

The Open dialog box appears. Kidspiration shows you the
names of any files that can be opened.

2 Select the folder where the file is located.

3 Click the file that you want to open, and then click Open.

If you are using Windows, you can specify what type of
document you want to open. On the Files of type list, select the
file type. Here are your choices:

♦ Kidspiration (.kid) opens other Kidspiration projects

♦ Inspiration (.ins) opens Inspiration 6 files.
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Open an Inspiration file

Kidspiration can open Inspiration 6 files. When you open an
Inspiration file, you may lose some elements and formatting in the
Inspiration file. Following is a list of changes that may occur when
you open an Inspiration file in Kidspiration:

♦  Hidden notes text will appear as notes automatically.

♦  Hidden sub-topics will appear automatically.

♦  Hidden symbols and links will appear automatically.

♦  Graphics inserted into notes will be deleted.

♦  Projects will always fit to one page when printing in Picture
view.

♦  The checklist will be deleted.

♦  Any child documents will be deleted.

♦  Strip symbols will appear but are not editable.

♦  Some special text formatting, such as superscript and subscript,
will not appear.

♦  Macintosh Publishers are deleted. Subscribers are converted to
external graphics and the connection between the subscriber
and the Inspiration file is removed.
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Working in Picture View

Working with visual ideas

In Picture view, you use symbols to show your ideas. You use
links or SuperGrouper categories to show how these ideas flow
and connect. After you get your ideas down, it’s easy to arrange,
group, and sort your ideas. You also can add text to symbols and
links. Kidspiration gives you many different tools to help you
capture and organize your ideas visually.

Topics covered in this section include the following:

♦  Adding symbols to a diagram

♦  Changing the shape of a symbol

♦  Adding text to a symbol

♦  Connecting symbols using links

♦  Adding text to a link

♦  Categorizing symbols using the SuperGrouper tool
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Example: A concept map about elephants

Using text to connect symbols is the basis of concept mapping, a
visual learning technique used primarily in science and social
studies curriculum. Concept mapping allows you to show
connections between facts and helps with understanding and
retention.

Start with your first idea.

Connect ideas and show how
ideas relate using links. In this
example, text on the links connects
concepts.

Add supporting ideas
using symbols.

Add supporting ideas
using symbols.
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Working with symbols

Add symbols to a diagram

There are several ways to add symbols to a diagram:

♦ You can add a symbol using the Symbol palette. Drag a symbol
from the palette to add it to your diagram.

–or–

♦ You can add linked symbols using the Add Symbol tool. Click

the Add Symbol button  and a new symbol will appear
that is linked to the currently selected symbol. Click the Add

Symbol button  again, and another symbol appears
connected to the selected symbol. Continue clicking to add as
many symbols as you need.

–or–

♦ You can click anywhere and type. A symbol with your idea
appears automatically. Add symbols by clicking and typing
when you want to get ideas down quickly, but aren’t yet sure
how you want to arrange or connect the ideas.

Add a symbol using the Symbol palette

Use the Symbol palette to add symbols to your diagram.

To add a symbol using the Symbol palette:

♦ Drag the symbol onto your diagram.

Tip:
To change the shape of a symbol, select it, and then click a new
symbol on the Symbol palette.
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Add a symbol using the Add Symbol tool

Use the Add Symbol tool to add linked symbols to your diagram.
Each symbol you add is connected to the currently selected symbol.
The Add Symbol tool is great for brainstorming when you want to
add a number of linked symbols to one idea.

To add a symbol using the Add Symbol tool:

♦ First select the symbol to which you want to connect the new
symbol, and then click the Add Symbol button.

–or–

If no symbol is selected, click the Add Symbol button to add a
new symbol. Click the Add Symbol button again to add a
symbol connected to the first.

Move a symbol

♦ To move a symbol, drag it to the new location.

Any links attached to the symbol will be adjusted
automatically.
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Add text to a symbol

Some symbols are shapes, such as a circle or oval, which let you
type an idea inside the symbol. Other symbols are captioned, with
space for text below the symbol. When you select a symbol, a
dotted line surrounds the symbol’s text area.

♦ To add text to a symbol, select the symbol, and then type.

To edit the text in a symbol, select the symbol and click inside
the text area to make your changes.

Change the shape of a symbol

1 Select the symbol that you want to change.

2 On the Symbol palette, click the new symbol.

Basic symbol shapes have a
text area inside the symbol.

Captioned symbols have a
text area below the symbol.
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Change symbol text

Picture-to-Topic translates pictorial symbols in Picture view to
words in Writing view. This setting is designed for developing
writers. When you return to Picture view, the symbol labels appear
below the symbols. You can change the text that appears below the
symbol in Picture view.

To change symbol text:

1 Select the text inside the symbol’s text area.

2 Type the text that you want.

To change symbol text, type the
new text in the symbol’s text area.
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Working with links

Links show relationships between ideas. When you add links in
Kidspiration, they are automatically updated as you work with the
symbols in your diagram.

Connect symbols using links

1 Click the Link Symbols button.

2 Click the symbol where you want the link to start, and then
click the symbol where you want the link to end.

3 To turn off the Link Symbols tool, click the Link Symbols
button.

Click the symbol to select it, and then click
the Link Symbols button…

…and then click the symbol you
want to create a link to.
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Move a link

1 Click the link.

2 Drag the end of the link to the new location on the current
symbol or move it to another symbol.

Add text to a link

You can add text to a link to expand your ideas or create a
relationship between two ideas. When you select a link, a dotted
line surrounds the link’s text area.

♦ To add text to a link, select the link, and then type.

To edit the text on a link, select the link and click inside the
text area to make your changes.

Select the end of the
link that you want to
move…

…and then drag it to the new
location on the symbol.

To add text to a link, select the link,
and then type in the text area.
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Move the text on a link

♦ To move the text on a link, select the link, and then drag the
handle on the text box to adjust the location of the text.

Working with the SuperGrouper tool

SuperGrouper categories provide an easy way to create logical
groupings of symbols. For example, you might create two
SuperGrouper categories one titled “Things that are alive” and
one titled “Things that are not alive” and ask students to put
appropriate symbols in each SuperGrouper category. To make an
exercise like this simpler, you can create a custom symbol library
that contains symbols of your choosing.

SuperGrouper categories have a text area at the top for labeling the
group. In Writing view, the SuperGrouper title assumes a top-level
position, and the symbols it contains appear as ideas below the
SuperGrouper category.

To move the text on a link, drag the
handle on the text box.
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Add a SuperGrouper category to a diagram

♦ Click the SuperGrouper button, and then click the
SuperGrouper shape you want.

Tip:
Any symbols that are selected before you add a SuperGrouper
category are automatically added to the category.

Add a title to a SuperGrouper category

You can add a title to the top of a SuperGrouper category.

To add a title to a SuperGrouper category:

♦ Select the SuperGrouper category, and then type.

To add a SuperGrouper category to your diagram,
click the SuperGrouper button…

…and, then click the shape that you want.
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Add symbols to a SuperGrouper category

♦ To add symbols to a SuperGrouper category, use one of the
following methods:

Drag a symbol to the SuperGrouper category.

–or–

Drag the SuperGrouper category over a symbol.

–or–

Select the SuperGrouper category, and then click the Add

Symbol button . You can add as many default symbols to
the SuperGrouper category as you want.

–or–

Select the symbols that you want to add to a SuperGrouper
category, and then add the SuperGrouper category to your
diagram.

Remove symbols from a SuperGrouper
category

♦ To remove a symbol from a SuperGrouper category, drag it to
another location.

–or–

To delete the symbol, select it, and then click the Clear button.
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Cutting, copying, and pasting symbols and links

Select a symbol

♦ To select a symbol, click it.

When you select a symbol, a resize handle appears at each
corner of the symbol, and a dotted line surrounds the symbol’s
text area.

Select multiple symbols

♦ To select multiple symbols, press Shift, and then click each
symbol you want to select.

–or–

Drag the pointer so the marquee surrounds the symbols that
you want to select. For more information, see “Select a part of
a diagram” later in this guide.

Select both symbols and links

♦ To select both symbols and links, press Shift, and then click
each symbol and link you want to select.

–or–

Drag the pointer so the marquee surrounds the symbols that
you want to select. For more information, see “Select a part of
a diagram” later in this section.

To select a symbol, click it.
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Select a part of a diagram

♦ Drag the pointer so the marquee surrounds the symbols that
you want to select.

Select everything on a diagram

♦ To select everything on your diagram, click Select All on the
Edit menu.

Delete a symbol

♦ To delete a symbol or SuperGrouper category, select it, and
then click the Clear button.

To select part of a diagram, drag the
pointer so the marquee surrounds the
symbols that you want to select.
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Delete a link

When you delete a link, you remove the relationship between the
symbols that are connected by the link. The remaining symbol or
symbols become unconnected ideas.

To delete a link:

1 Select the link you want to delete.

2 Click the Clear button.

Delete a symbol and its links

When you delete a symbol, you automatically delete any links that
connect it to other symbols.

To delete a symbol and its links:

1 Select the symbol you want to delete.

2 Click the Clear button.

Cut and paste symbols

1 Select the symbols that you want to delete from their current
location and paste into another location in your diagram.

2 On the Edit menu, click Cut.

3 Click where you want the selection to appear, and then click
Paste on the Edit menu.

Tip:
To select multiple symbols, press Shift, and then select each
symbol.
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Copy and paste symbols

1 Select the symbols that you want to paste into another place in
your diagram.

2 On the Edit menu, click Copy.

3 Click where you want the selection to appear, and then click
Paste on the Edit menu.

Undo changes

♦ To undo the last change you made, click the Undo button.

Using custom symbols and graphics

Insert a graphic into a diagram

You can insert graphics created in other programs into a diagram.
On the Macintosh, you can insert PICT, JPEG and GIF files. In
Windows, you can insert WMF, BMP, JPEG and GIF files.

To insert a graphic into a diagram:

1 On the File menu, click Import a Graphic.

2 Open the folder where the graphic is located.

3 Click the graphic file in the list, and then click Open.

Tips:
• You can drag and drop graphics files into a diagram. On the

Macintosh, you can drag and drop PICT, JPEG and GIF files.
In Windows, you can drag and drop WMF, BMP, JPEG and
GIF files. Before you drag and drop a graphics file, turn off
Hide Desktop in Application Options (click Application
Options on the Teacher menu).
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• You can copy and paste graphics into a diagram. Copy the
graphic, and then open your diagram and click Paste on the
Edit menu.

Changing the view

Magnify or reduce the view of your diagram

♦ To magnify or reduce the view of a diagram, click the Magnify
button  in the lower left corner of the Kidspiration window.
Click again to change the magnification.

Switch to Writing view

♦ To view your diagram as a writing project, click the Go to
Writing button.



Working in Writing View 71

Working in Writing View

Working with written ideas

In Writing view, developing writers can expand the ideas they
captured in Picture view. Each symbol becomes an idea with a
notes area where students can write. More experienced writers can
start a writing project from scratch using the Kidspiration tools to
arrange, organize, and expand their ideas. Here are some ways to
use Writing view:

♦  Create a student journal

♦  Create written lists

♦  Write a story or report

Topics covered in this section include the following:

♦  Using the ideas in a diagram to begin writing

♦  Adding ideas

♦  Adding details to ideas

♦  Moving ideas up or down in the hierarchy

♦  Cutting, copying, and pasting ideas

♦  Switching to Picture view
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Example: A report about elephants

In Writing view, ideas and connections established in a diagram are
translated into a writing project that shows main ideas and
supporting ideas. This view provides another useful way to show
information, and supports the translation of ideas from visual to
verbal.

First Idea

Notes

Supporting idea

Supporting idea

Supporting idea
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Use the ideas in a diagram to begin writing

You can use the ideas in a diagram to begin writing by switching to
Writing view. In Writing view, symbol text becomes ideas. When a
symbol has no text, the symbol’s label appears as the idea. For
example, a symbol with the label “Sun” becomes the idea “Sun” in
Writing view. This special function, called Picture-to-Topic, helps
emerging readers and writers associate words with images. When
you return to Picture view, text you added to your ideas in Writing
view appear in the symbols.

If you do not want symbol labels to appear as ideas in Writing
view, you can turn off the Picture-to-Topic setting.

To use the ideas in a diagram to begin writing:

1 Add symbols that represent your ideas to your diagram.

If you use symbols only, they must be pictorial, for example a
symbol of a dog or a sun, to take advantage of Picture-to-
Topic.

2 To switch to Writing view, click the Go to Writing button.

The symbol labels appear as ideas in Writing view.

See Also

“Turn Picture-to-Topic on or off” in “Setting Application
Options” later in this guide.

“Change symbol text” in “Working with Symbols” earlier in
this guide.
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Add an idea in Writing view

1 Click the Add Idea button, and then type the new idea.

2 If necessary, adjust the location of the idea by doing one of the
following:

♦ Drag the new idea to the location where you want it.
–or–

♦ To change the level of the idea in the hierarchy, click the
Move Left or Move Right button.

 

Add details to an idea

You can expand your ideas by adding details—also called notes. A
line separates an idea from its notes. The notes area is always
available. As you add more notes text, the notes area automatically
expands.

To add details to an idea:

♦ Click in the area below the idea, and then type.

Click in the notes area of an idea,
and then type to add details.
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Move an idea up or down in the hierarchy

♦ To move an idea up or down, point to the left of the idea. When

the grabber hand  appears, drag the idea to the new location.

You can also drag an idea to the left or right to adjust its level.

Cutting, copying, and pasting ideas

Select an idea in Writing view

♦ To select an idea in Writing view, click the left edge of the
symbol.

When you select an idea, the border that surrounds the idea
becomes bold.

Select multiple ideas in Writing view

♦ To select multiple ideas in Writing view, press Shift, and then
click the left edge of each idea you want to select.

Select all the ideas in Writing view

♦ To select all the ideas in Writing view, click Select All on the
Edit menu.

To select an idea, click the left edge.

When you select an idea, the border that
surrounds the idea becomes bold.
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Delete an idea in Writing view

When you delete an idea in your writing project, the supporting
ideas below that idea are deleted as well.

♦ To delete an idea, select it, and then click the Clear button.

Copy and paste ideas in Writing view

When you copy an idea, you also copy any supporting ideas below
the idea. You cannot copy an idea when you are in text editing. For
more information, see “Edit text in an idea” in “Editing Text” later
in this guide.

To copy and paste ideas in Writing view:

1 Select the ideas that you want to paste into another place in
your project.

2 On the Edit menu, click Copy.

3 Click where you want the selection to appear, and then click
Paste.

Tip:
To select multiple ideas, press Shift, and then select each idea.
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Cut and paste ideas in Writing view

When you click Cut on the Edit menu, you also remove any
supporting ideas below the idea. You cannot cut an idea when you
are in text editing. For more information, see “Edit text in an idea”
in “Editing Text” later in this guide.

To cut and paste ideas in Writing view:

1 Select the idea or ideas that you want to delete from the current
location and paste into another location.

2 On the Edit menu, click Cut.

3 Click where you want the selection to appear, and then click
Paste.

Changing the view

Switch to Picture view

♦ To view your writing project as a diagram, click the Go to
Pictures button
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Changing the Appearance of Projects

Formatting text

You can change the look of the text in Picture view or Writing
view using font, text size, text style, and color. You can change all
the text in a symbol, link or idea by selecting the symbol, link, or
idea. You can change the formatting of words or single characters
by selecting the words or single characters.

This section includes the following topics:

♦  Changing the font

♦  Changing the text size

♦  Applying bold formatting to text

♦  Applying italic formatting to text

♦  Underlining text

♦  Changing the color of text

Change the font

1 Select the symbol, link, idea, or words that you want to change.

2 To change the font, click the arrows on the Font box

.

When you select a symbol, link, or idea, and change its font,
the change you make applies to new symbols, links, and ideas.
New symbols and links are not affected by font changes to text
selections within symbols, links or ideas.
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Change the text size

1 Select the symbol, link, idea, or words that you want to change.

2 To change the text size, click the arrows on the Text Size box

.

When you select a symbol, link, or idea, and change its text
size, the change you make applies to new symbols, links, and
ideas. New symbols and links are not affected by text size
changes to text selections within symbols, links or ideas.

Apply bold formatting to text

1 Select the symbol, link, idea, or words that you want to change.

2 Click  on the Formatting toolbar.

When you select a symbol, link, or idea, and apply bold
formatting, the change you make applies to new symbols, links,
and ideas. New symbols and links are not affected by bold
formatting applied to text selections within symbols, links or
ideas.

Apply italic formatting to text

1 Select the symbol, link, idea, or words that you want to change.

2 Click  on the Formatting toolbar.

When you select a symbol, link, or idea, and apply italic
formatting, the change you make applies to new symbols, links,
and ideas. New symbols and links are not affected by italic
formatting applied to text selections within symbols, links or
ideas.
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Underline text

1 Select the symbol, link, idea, or words that you want to change.

2 Click  on the Formatting toolbar.

When you select a symbol, link, or idea, and apply underline
formatting, the change you make applies to new symbols, links,
and ideas. New symbols and links are not affected by underline
formatting applied to text selections within symbols, links or
ideas.

Change the color of text

1 Select the symbol, link, idea, or words that you want to change.

2 Click  on the Formatting toolbar, and then click the color
that you want.

When you select a symbol, link, or idea, and change its colors,
the change you make applies to new symbols, links, and ideas.
New symbols and links are not affected by changes to text
selections within symbols, links or ideas.
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Formatting symbols and SuperGrouper
categories

You can change the look of symbols and SuperGrouper categories
using color, line thickness, and size.

This section includes the following topics:

♦  Changing the line thickness of a symbol or SuperGrouper
shape

♦  Changing the colors of a symbol or SuperGrouper shape

♦  Changing the size of a symbol or SuperGrouper shape

Change the line thickness of a symbol or
SuperGrouper shape

You can choose from three line thicknesses for symbols and
SuperGrouper shapes.

To change line thickness of a symbol or SuperGrouper
shape:

1 Select the symbols or SuperGrouper shape that you want to
change.

2 Click  on the Formatting toolbar until the symbols or
SuperGrouper shape have the line thickness that you want.

Any new symbols or SuperGroupers shapes that you add will
have the same line thickness.
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Change the colors of a symbol or SuperGrouper
shape

You can change the look of symbols and SuperGrouper shapes
using color. You can select one symbol and then change the colors
of that symbol. Or, if there are multiple basic symbols with the
same colors (for example, oval or rounded rectangle), you can
select these symbols and change the colors of all the symbols at one
time.

To change the colors of a symbol or SuperGrouper
shape:

1 Select the symbol or SuperGrouper shape.

2 The Symbol Colors tool appears on the Formatting toolbar.

Only the colors that appear in the symbol appear in the Symbol
Colors tool.

3 Click the color you want to change, and then click a new color
to replace the existing color.

If you change the colors of a basic symbol (oval, rectangle,
text, or rounded rectangle), any new basic symbols that you
add to your diagram will be the same colors.

Note:
You cannot change the colors of photographic images.

To revert to a symbol or SuperGrouper shape’s original
colors:

When you change the colors in a multicolor symbol or
SuperGrouper shape, an X appears in the Symbol Colors tool on
the Formatting toolbar. Click the X to revert to the symbol or
SuperGrouper shape’s original colors.
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Change the size of a symbol or SuperGrouper
shape

You can change the size of symbols and SuperGrouper shapes.

To change the size of a symbol or SuperGrouper shape:

1 Select the symbol or SuperGrouper shape.

2 Drag the lower right handle to resize a symbol proportionally.

–or–

Drag any of the other handles to stretch the symbol vertically
or horizontally.

Tip:
To resize a symbol proportionally using any handle, press
Control (Macintosh) or Ctrl (Windows) when you drag the
handle.

Select the lower right handle…

…and then drag to increase or decrease
the size of the symbol proportionally.
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Formatting links

You can change the look of links using color, line thickness, line
style, and arrowhead style.

This section includes the following topics:

♦  Changing the thickness of a link

♦  Creating a dashed link

♦  Changing arrowhead style

♦  Changing the color of a link

Change the thickness of a link

You can choose from three line thicknesses for a link. You can also
make a link a dashed line.

To change the thickness of a link:

1 Select the link or links that you want to change.

2 On the Formatting toolbar, click  until the links are the line
thickness that you want.

Any new links that you create will be the same line thickness.

Create a dashed link

1 Select the link or links that you want to change.

2 On the Formatting toolbar, click  until the links are dashed
lines.

Any new links that you create will be dashed lines.
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Change arrowhead style

You can choose from two arrowhead styles: single arrowhead or
double arrowhead. You can also choose a link with no arrowhead.
You can use a single arrowhead to indicate a one-way relationship
between symbols. You can use a double arrowhead to indicate a
two-way relationship between symbols. For example, in a diagram
describing a journey from one place to another you might use
single arrowheads. In a diagram showing how you and a friend
communicate using e-mail, you might use double arrowheads.

To change arrowhead style:

1 Select the link or links that you want to change.

2 On the Formatting toolbar, click  until the links have the
arrowhead style that you want.

Any new links that you create will have the same arrowhead
style.

Change the color of a link

1 Select the link.

The Link Color tool appears on the formatting toolbar.

2 Click the color to change it, and then click a new color to
replace the existing color.

Any new links that you create will be the same color.
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Formatting the page

Change the background color of a project

Changing the background color of your project is another way to
customize the look of your work. If you are working on a project
about the world’s oceans, you might want to use a blue background
for instance.

To change the background color of your project:

1 On the Goodies menu, click Background Color.

2 Click the color that you want.

When you print your project on a black and white printer, the
background color will appear as a shade of grey.

Change the colors of the lined paper

Changing the colors of the lined paper is another way to customize
the look of your work.

To change the colors of the lined paper:

1 On the Goodies menu, click Lined Paper Colors.

2 Click a color to change it.

The colors of the lined paper also will appear when you print.

When you print on a black and white printer, the colors of the
lined paper will print as shades of grade.

Choose the prefix style in Writing view

There are four prefix styles to choose from. You can also choose to
have no prefix style.

♦ To choose a prefix style, click  on the Formatting toolbar
until you see the prefix style that you want.
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Show or hide the lined paper

For some projects, you may want your writing to appear in a more
continuous format. Hiding the lined paper removes the visual
distinction between ideas in Writing view.

♦ To show or hide the lined paper, click  on the Formatting
toolbar.
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Editing Text

Edit text in a symbol

♦ To add or edit text in a symbol, select the symbol, click in the
symbol’s text area, and then type.

Edit text in an idea

♦ To edit text in an idea, click in the idea, and then type.

Basic symbol shapes have a
text area inside the symbol.

Captioned symbols have a
text area below the symbol.

To edit an idea, click inside it.

The border around the idea becomes a dashed
line when you are adding or editing text.
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Copy and paste text

1 Select the text that you want to paste into another place in your
project.

2 On the Edit menu, click Copy.

3 Click in your project where you want the selection to appear,
and then click Paste on the Edit menu.

Cut and paste text

1 Select the text that you want to cut and paste into another place
in your project.

2 On the Edit menu, click Cut.

3 Click in your project where you want the selection to appear,
and then click Paste on the Edit menu.

Select a word

There are two ways to select a word.

♦ Double-click the word.

–or–

Click in front or behind the word, and then drag the mouse
pointer across the word.
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Check your spelling

1 On the Goodies menu, click Spell Check to check the spelling
in your project.

2 When the spelling checker finds a misspelled word, you have
several options:

To change the spelling of a word to the suggested dictionary
spelling, click Change.

–or–

To keep the spelling of the word as it is throughout the project,
click Ignore All.

–or–

To keep the spelling of the word in this instance only, click
Ignore Once. The spelling checker will continue to find other
occurrences of this word.

–or–

To add the word to the user dictionary, click Add. After you
add a word to the dictionary, the spelling checker will not
suggest other spellings for the word.
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Edit the user dictionary

You can add words to the dictionary and edit words in the
dictionary. You can add and edit words as you are checking the
spelling in your project.

To edit the user dictionary:

1 On the Goodies menu, click Spell Check.

2 Do one of the following:

To add a word to the user dictionary, click Add. After you add
a word to the dictionary, the spelling checker will not suggest
other spellings for that word.

–or–

To edit the spelling of a word, click Edit. Change the spelling
of the word to your preferred spelling. The spelling checker
will use the new spelling for the word.
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Using Audio in Kidspiration Projects

Use audio in a Kidspiration project

You can use audio in your Kidspiration projects in several ways:

♦  The Talking Interface

For developing readers, the Talking Interface reads menus,
buttons, and other program elements on-screen.

♦  The Listen tool 

The Listen tool helps students with reading and writing by
reading the words in their projects.

♦  The Record command (Click Record on the Goodies menu)

Students can use the Record command to record words and
sounds and attach them to symbols or ideas to expand and
reinforce learning. Teachers can also record instructions for
students to use in an activity.

Read the text in program menus and buttons

The computer will read the text in program menus and buttons
when Talking Interface is turned on in Application Options (click
Application Options on the Teacher menu).

To read the text in program menus and buttons:

♦ Point to a menu or button.

The computer will read the text in the menu or button.

See Also

“Turn the Talking Interface on or off” in “Setting Application
Options” later in this guide.
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Listen to the ideas in a project

The Listen tool is available only when the Listen Tool is enabled in
Application Options (click Application Options on the Teacher
menu). You can use the Listen tool to read any text that is added to
a project in either Picture or Writing view.

To listen to the ideas in a project:

1 Click the Listen button.

2 Click the symbol or idea that you want the computer to read.

3 To turn the Listen tool off, click the Listen button.

See Also

“Enable or disable the Listen tool” in “Setting Application
Options” later in this guide.

Choose the voice that the computer uses

You can choose the voice that the computer uses when you use the
Listen tool or the Talking Interface.

To choose the voice that the computer uses:

1 On the Sound menu, click Voices.

2 Click the voice in the list box, and then click Choose.



Using Audio in Kidspiration Projects 95

Record a sound or words and attach them to a
symbol or idea

You can record a sound or words and attach them to a symbol or
idea to expand and reinforce learning. The Record command is
only available when Record Sounds is turned on in Application
Options (click Application Options on the Teacher menu). Your
computer needs a microphone to record sounds.

To record a sound or words and attach them to a symbol
or idea:

1 Select the symbol or idea.

2 On the Sound menu, click Record.

3 In the recording control box, click Record to begin recording.

4 Generate the sound that you want to record.

The maximum length of a recorded sound is fifteen seconds.
You can click Stop at any time to end recording.

5 When you finish recording, click Save to save the recording
and attach it to the selected symbol or idea.

In Picture view, a speaker symbol  appears in the upper
right corner of a symbol when a recorded sound is attached. In
Writing view, a speaker symbol appears to the left of an idea
when a recorded sound is attached.

See Also

“Turn sound recording on or off” in “Setting Application
Options” later in this guide.
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Play a recorded sound attached to a symbol
or idea

♦ To play a recorded sound, click the speaker  on the symbol
or idea.

Erase a recorded sound

1 Select the symbol or idea.

2 On the Sound menu, click Erase.
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Printing

Print a project

♦ To print a project, click Print on the File menu.

In Picture view, a project always prints on one page.

Print page numbers on a writing project

Page numbers appear only when you print a project in Writing
view.

To print page numbers on a writing project:

1 Click the Student Name button.

2 Select the Print Page Numbers check box.

When you print, the page numbers appear at the bottom of the
page.
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Print your name at the top of the page

You can add your name to a project so when you print, your name
appears at the top of every page. You can also include information
other than your name. For example, you might want the student’s
name to appear in the upper left corner and the teacher’s name,
grade, and room number to appear in the upper right corner of the
page.

To print your name at the top of the page:

1 On the Toolbar, click the Student Name button.

2 Type you name in the box where you want the name to appear.

For example, if you want the name to appear in the upper left
corner of the page, type your name in the Left box.

Select paper size

You can choose the paper size for a Kidspiration project. In Picture
view, the workspace is scaled to the paper size selected in Page
Setup (File menu). If you change the paper size in Picture view, the
paper size also changes in Writing view.

To select the paper size:

1 On the File menu, click Page Setup.

2 In the Paper list, click the paper size that you want
(Macintosh).

–or–

Under Paper, click the paper size that you want in the Size list
(Windows).
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Set page orientation

You can choose landscape or portrait orientation for a project. In
Picture view, landscape orientation is the default. In Writing view,
portrait orientation is the default. If you change the page orientation
in Picture view, the page orientation does not change in Writing
view.

To set page orientation:

1 On the File menu, click Page Setup.

2 Next to Orientation, click the Portrait or Landscape icon
(Macintosh).

–or–

Under Orientation, select Portrait or Landscape (Windows).

Scale a project for printing

In Picture view, a diagram always prints on one page. You cannot
scale a diagram in Kidspiration. However, you can change the page
size, and then design a diagram to fill the new page size.
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Teacher’s Reference

Turning the Teacher menu on or off

The Teacher menu provides access to settings and features that
allow teachers to customize Kidspiration and create their own
classroom activities. When the Teacher menu is on, a checkmark
appears next to the command, and the items on the Teacher menu
are available.

♦ To turn the Teacher menu on or off, click Enable Teacher
Menu on the Teacher menu.

Using the Kidspiration activities

The Kidspiration learning activities focus on a specific subject or
skill. Each activity is a separate file that includes instructions on
how to use the activity. Kids can complete an activity and then save
it as their own project. The Kidspiration activities include the
following:

♦  Reading & Writing

♦  Social Studies

♦  Science

There is also a group of activities organized under the category
“More.” In addition to the activities that come with Kidspiration,
teachers can create their own activities or modify an existing
activity.
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Open an activity

1 Start Kidspiration.

–or–

On the File menu, click New.

2 Under Activities, click a category, for example “Science.”

3 Double-click an activity to open it.

Create an activity

You can create an assignment or project in Picture or Writing view,
and then save the exercise as an activity so it will be available in
the Activities menu in the Kidspiration Starter. When you save the
activity, the Kidspiration Activity Wizard prompts you to select
default settings for the activity and provide a name, description,
and category for the activity.

To create an activity:

1 Create the assignment or project in Writing or Picture view.
See the Tips below for creating activities.

2 Enable the Teacher menu.

3 On the Teacher menu, click Save As Activity.

4 Select the default settings you want for the activity.

5 Click the category that you want the activity to appear under,
for example “Science.”

6 In the Activity Name box, type a name for the activity.

7 In the Description of Activity box, type a description for the
activity.
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8 When you are finished setting up the activity, click Finish.

Tips:
• Numbered Steps: Many of the Kidspiration activities include

step-by-step instructions. To create numbered steps in your
own activities, use the numbered symbols under Numbers and
Letters on the Symbol palette.

• Custom Symbol Libraries: If you want specific symbols to be
available for an activity, you can create a custom symbol
library that contains the symbols you want, and then select the
custom library as the Default Library for the activity.

See Also

“Create a new symbol library” in “Working with the symbol
libraries” later in this guide.

Modify an activity

Kidspiration comes with a variety of activities for you to use in the
classroom. You may want to modify an activity in some cases.

To modify an activity:

1 Open the activity.

2 Make any changes.

3 Enable the Teacher menu.

4 On the Teacher menu, click Save As Activity.

5 Select the default settings you want for the activity.

6 Select the category that you want the activity to appear under,
for example “Science.”

7 In the Activity Name box, type a name for the activity.

8 In the Description of Activity box, type a description for the
activity.
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9 When you are finished modifying the activity, click Finish.

Tip:
If you want specific symbols to be available for an activity, you
can create a custom symbol library that contains the symbols
you want, and then select the custom library as the Default
Library for the activity.

See Also

“Create a new symbol library” in “Working with the symbol
libraries” later in this guide.

Share an activity with another computer

You can share an activity on your computer with multiple
computers.

To share an activity with another computer:

1 Open the Kidspiration Activities folder on your computer.

2 Copy the activity file to a network server or floppy disk.

3 Copy the activity file to the Kidspiration Activities folder on
the other computer.
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Adding Internet hyperlinks to projects

Add a hyperlink to a project

You can add hyperlinks to ideas, notes, symbols, and links. The
hyperlinks are active in Picture view and Writing view. This is a
great way for teachers to direct students to the Internet to gather
information for their projects.

Before you add a hyperlink, make sure URL Hyperlink Auto-
detection is turned on in Application Options (click Application
Options on the Teacher menu).

To add a hyperlink:
♦ Type the Internet address where you want the hyperlink to

appear. For example:

www.inspiration.com

After you add the hyperlink, when you move the mouse pointer
over the link, the pointer looks like this . This pointer indicates
that the hyperlink is active. Clicking the hyperlink will start the
default browser and open the Web site.

Add a hyperlink to selected text

You can assign hyperlinks to selected text in ideas, notes, symbols,
and links. The hyperlinks are active in Picture view and Writing
view. This allows you to create hyperlinks without long cryptic
names, for example “Click Here” rather than
“http://www.inspiration.com/science/amphibians/project.htm.”

To add a hyperlink to selected text:
1 Select the text to which you want to assign the hyperlink.

2 Enable the Teacher menu.
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3 On the Teacher menu, click URL Hyperlink.

The text you selected appears in the Hyperlink Text box. You
can edit the text if you wish.

4 In the Hyperlink Address box, type the Internet address that
you want to assign to the text. For example:

www.inspiration.com

Note:
When you assign a hyperlink at the end of a text area (for
example, at the end of the text in an idea or symbol), the text
you type after the hyperlink is included in the hyperlink. To
prevent text that follows a hyperlink from being included, type
all the text in the symbol or idea first, and then add the
hyperlink.

Remove a hyperlink

♦ Select the hyperlink, and then click the Clear button.

–or–

1 Select the text to which the Internet address is assigned.

2 On the Teacher menu, click URL Hyperlink.

3 Click Remove Hyperlink.
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Changing the default look for projects

Change the default look for new projects

You can customize the default settings for new projects.

To change the default look for new projects:

1 On the Teacher menu, click Save Default Settings.

2 Use the Default Settings Wizard to select the settings that you
want.

3 When you are finished selecting settings, click Finish.

New projects you start will use the settings that you selected.

Share the default look for new projects with
another computer

You can share the default look for new documents on your
computer with multiple computers.

To share the default settings for new projects with
another computer:

1 Open the Kidspiration Activities folder inside the
Kidspiration folder on the hard disk of your computer.

2 Copy the Default Settings file to a network server or floppy
disk.

3 Copy the Default Settings file to the Kidspiration Activities
folder on the other computer.
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Setting Application Options

Turn the Talking Interface on or off

The Talking Interface reads all text in the Kidspiration interface,
including all menus and buttons. The Talking Interface is designed
for developing readers and writers. If your students are readers, or
are familiar with Kidspiration, you may not want the Talking
Interface to be available.

To turn the Talking Interface on or off:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Talking Interface check box.

Enable or disable the Listen tool

The Listen tool reads the words in an idea or symbol. You may not
want the Listen tool to be available in some cases.

To enable or disable the Listen tool:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Listen tool check box.
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Turn sound recording on or off

The Record command lets you record a sound and attach it to a
symbol or idea. You may not want students to be able to record
sounds in some cases.

To turn sound recording on or off:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Record Sounds check box.

Tip:
Turning off sound recording does not prevent students from
playing sounds that have already been recorded. This allows a
teacher to record instructions, and then turn off sound
recording. Students can click the speaker icon to hear the
teacher instructions, but cannot record their own sounds.

Turn animation on or off

Animated symbols can add a new dimension to your diagrams. A
number of animated symbols are included in the symbol libraries.
One example is the traffic light symbol in the Basic Library. You
can also create your own animated symbols by inserting animated
GIF files into the symbol libraries.

You may not want animation to be activated in some cases. When
you turn off animation, only the first frame of the symbol displays.

To turn animation on or off:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Animation Enabled check box.

See Also

“Insert custom symbols and graphics into the symbol libraries”
later in this guide.
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Show or hide the desktop running behind
Kidspiration

Kidspiration includes a “hidden desktop” feature. This hides the
computer workspace behind Kidspiration to minimize distractions
and prevent students from inadvertently leaving Kidspiration. In
some cases, you may want the programs and files on the
computer’s desktop to show when Kidspiration is running. For
example, it may be helpful to have access to the desktop when
adding new symbols to the symbol libraries.

To show or hide the desktop running behind
Kidspiration:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Hide Desktop check box.

Turn the spelling checker on or off

In some cases, you may not want students to check their work
using the spelling checker.

To turn the spelling checker on or off:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Spell Check Enabled check box.
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Turn URL hyperlinks on or off

URL hyperlinks are links to the Internet in a Kidspiration project.
When you click a URL hyperlink, your Web browser starts and
opens the associated Internet address. You may not want hyperlinks
to be active in some cases. For example, it may be helpful to
disable hyperlinks when you are editing Internet addresses in a
project or when you do not want a project to provide access to the
Internet.

To turn URL hyperlinks on or off:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the Live Hyperlinks check box.

Automatically format Internet addresses as URL
hyperlinks

When you type an Internet address in a Kidspiration project, the
address is automatically formatted as an URL hyperlink. In some
cases, you may not want an Internet address to be recognized as a
hyperlink.

To turn on or off automatic formatting of Internet
addresses:

1 Enable the Teacher menu.

2 On the Teacher menu, click Application Options.

3 Select or clear the URL Hyperlink Auto-detection check box.
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Turn Picture-to-Topic on or off

Picture-to-Topic translates pictorial symbol labels in Picture view
to words in Writing view. This setting is designed for developing
writers. In some cases, you may not want symbol labels to appear
as idea text in Writing view. When Picture-to-Topic is on, a
checkmark appears next to the command.

To turn Picture-to-Topic on or off:

♦ On the Teacher menu, click Picture-to-Topic.

Working with the symbol libraries

Teachers have complete control of the Kidspiration symbol
libraries. It’s easy to add, change, or remove symbols to meet the
needs of your classroom. Often you may wish to create a custom
symbol library for use with a particular classroom activity that
you’re creating.

Topics covered in this section include the following:

♦  Inserting a symbol or graphic on your diagram into a symbol
library

♦  Inserting a graphics file into the symbol library

♦  Copying and pasting a graphic into a symbol library

♦  Copying a symbol from one library to another

♦  Deleting a symbol from a library

♦  Changing the order of symbols in a library

♦  Creating a new symbol category

♦  Creating a new symbol library

♦  Copying a symbol library

♦  Sharing a symbol library with another computer
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Insert a symbol or graphic on your diagram into
a symbol library

You can insert custom symbols and graphics on your diagram into
a symbol library so they are available for use on a regular basis.

To insert a symbol or graphic on your diagram into a
symbol library:

1 On your diagram, select the symbol or graphic that you want to
insert into a symbol library.

2 On the Symbol palette, display the library to which you want to
add the symbol.

There must be an open slot at the bottom of the library in order
to insert the symbol. If there are no open slots in the library,
Kidspiration places the symbol in the Custom category.

3 Enable the Teacher menu.

4 On the Teacher menu, click Install User Symbol.

5 Select the size that you want the symbol to be, and then click
OK.

♦ Select Standard Symbol Size to size the symbol
equivalent to the other Kidspiration symbols.
–or–

♦ Select Actual Size to retain the original size of the graphic.

When your symbol is installed, it appears at the bottom of the
Symbol library entries. It’s now ready for your use.

See Also

“Create a new Symbol library” later in this guide.



Kidspiration User’s Guide114

Insert a graphics file into a symbol library

You can insert graphics files into the symbol libraries so the
graphics are available as symbols. On the Macintosh, you can insert
PICT, JPEG, and GIF files. In Windows, you can insert WMF,
BMP, JPEG, and GIF files.

To insert a graphics file into a symbol library:

1 Enable the Teacher menu.

2 On the Teacher menu, click Edit Symbol Libraries.

The Edit Symbol Libraries dialog box appears.

3 On the Library 1 list, select the library to which you want to
add the graphic.

There must be an open slot at the bottom of the library in order
to add the symbol. If there are no open slots in the library,
Kidspiration creates a new library called User 1 under the
Custom category. When no slots are available in User 1,
Kidspiration creates a User 2 library and so on.

4 Click Import Graphic.

5 Select the graphic you want to install, and then click Open.

6 Select the size that you want the symbol to be, and then click
OK.

♦ Select Standard Symbol Size to size the symbol
equivalent to the other Kidspiration symbols.
–or–

♦ Select Actual Size to retain the original size of the graphic.
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7 In the Label box, type a name for the symbol.

When your symbol is installed, it appears in the first available
slot in the Symbol library. It’s now ready for your use.

Tip:
You also can drag and drop a graphics file into a symbol
library. On the Macintosh, you can drag and drop PICT, JPEG
and GIF files. In Windows, you can drag and drop WMF,
BMP, JPEG and GIF files. On the Symbol palette, display the
library to which you want to insert the graphic, and then drag
the file to the Symbol palette. If there is no available slot for
the graphic, Kidspiration places the graphic in the Custom
category as described above. Turn off Hide Desktop in
Application Options (click Application Options on the
Teacher menu) before you drag and drop a graphics file.

See Also

“Create a new Symbol library” later in this guide.
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Copy and paste a graphic into a symbol library

You can copy and paste graphics from other programs into the
symbol libraries so the graphics are available as symbols.

To copy and paste a graphic into a symbol library:

1 Copy the graphic.

2 In Kidspiration, enable the Teacher menu.

3 On the Teacher menu, click Edit Symbol Libraries.

4 On the Library 1 list, select the library to which you want to
insert the graphic.

There must be an open slot at the bottom of the library. If there
are no open slots, Kidspiration creates a new library called
User 1 under the Custom category. When no slots are available
in User 1, Kidspiration creates a User 2 library and so on.

5 Click Paste Graphic.

6 Select the size that you want the symbol to be, and then click
OK.

♦ Select Standard Symbol Size to size the symbol
equivalent to the other Kidspiration symbols.
–or–

♦ Select Actual Size to retain the original size of the graphic.

7 In the Label box, type a name for the symbol.

When your symbol is installed, it appears in the first available
slot in the Symbol library. It’s now ready for your use.

See Also

“Create a new Symbol library” later in this guide.
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Copy a symbol from one library to another

You can copy symbols from one library to another. The library you
copy the symbol to must have an available slot for the symbol.
Copying symbols is useful when you want to create a symbol
library with symbols that you use frequently.

To copy a symbol from one library to another:

1 On the Teacher menu, click Edit Symbol Libraries.

The Edit Symbol Libraries dialog box appears.

2 On the Library 1 list, select the library that contains the
symbol you want to copy.

3 On the Library 2 list, select the library to which you want to
copy the symbol.

4 Select the symbol you want to copy, and then drag it to the
location where you want it in the other library.

A copy of the symbol appears in its new location.

5 In the Label box, type a name for the symbol.

6 Do one of the following:

♦ To apply your changes, click OK.
–or–

♦ To cancel your changes, click Cancel.

Tip:
You can also change the order of symbols within a library.
Drag a symbol to move it to a new location. The other symbols
are automatically rearranged.
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Delete a symbol from a library

When you delete a symbol from a library, it is no longer available
to use in projects.

To delete a symbol from a library:

1 On the Teacher menu, click Edit Symbol Libraries.

The Edit Symbol Libraries dialog box appears.

2 On either the Library 1 or Library 2 list, select the library that
contains the symbol you want to delete.

A symbol can’t be deleted if it appears in a project that is open.

3 Drag the symbol to the Trash icon.

4 Do one of the following:

♦ To apply your changes, click OK.
–or–

♦ To cancel your changes, click Cancel.

Change the order of symbols in a symbol library

You can change the order of symbols in a symbol library.

To change the order of symbols in a library:

1 On the Teacher menu, click Edit Symbol Libraries.

The Edit Symbol Libraries dialog box appears.

2 On the other Library 1 list, select the library for which you
want to change the order of the symbols.

3 Select a symbol that you want to move, and then drag it to the
new location.

The other symbols are automatically rearranged.

4 Move as many symbols as you wish.
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5 Do one of the following:

♦ To apply your changes, click OK.
–or–

♦ To cancel your changes, click Cancel.

Create a new symbol category

When you create a new symbol library, it is automatically stored in
the Custom category on the Symbol palette unless you specify a
different category. You can create your own symbol categories to
store the symbol libraries that you create or libraries that you copy.

To create a new symbol category:

1 On the File menu, click Quit (Macintosh) or Exit (Windows).

2 Open the Kidspiration Libraries folder inside the
Kidspiration folder.

3 Create a new folder inside the Kidspiration Libraries folder.

Name the folder the same name as the category that you want
to appear on the Symbol palette. For example, if you want a
category called “Student Symbols,” then name the folder
“Student Symbols.”

4 Start Kidspiration.

The new category appears alphabetically in the list of
categories on the Symbol palette. You can now place symbol
libraries in the new category.
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Create a new symbol library

You can create new symbol libraries for symbols you import,
create, or copy from other libraries. For example, you might want
to create a new symbol library for the symbols you use frequently
or for an activity that you create. You can place a new symbol
library under any category on the Symbol palette. If you do not
choose a category, the symbol library is automatically stored in the
Custom category.

To create a new symbol library:

1 Enable the Teacher menu.

2 On the Teacher menu, click New Symbol Library.

3 In the Category list, select the category that you want the new
library to appear under on the Symbol palette.

4 In the Library box, type a name for the new library.

Copy a symbol library

You may want to copy the custom symbol libraries that you create
so you can make them available to other computers. Each symbol
library is a file with an INL extension that is stored in the
Kidspiration Libraries folder inside the Kidspiration folder.

To copy a symbol library:

1 Open the Kidspiration folder on your computer.

2 Double-click the Kidspiration Libraries folder to open it.

3 Double-click the folder that contains the symbol library.

The name of the folder is the Category name that the library
appears under on the Symbol palette, for example “Custom.”

4 Select the symbol library file.

5 Copy the file.
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Share a symbol library with another computer

You can share a custom symbol library with another computer
running Kidspiration by copying the symbol library file to a floppy
disk (or network server), and then copying the file to the
Kidspiration Libraries folder inside the Kidspiration folder on the
other computer.

To share a symbol library with another computer:

1 Copy the symbol library file to a floppy disk or network server.

2 Insert the floppy disk in the computer or connect to the network
server with which you want to share the symbol library.

3 On the computer, open the Kidspiration Libraries folder
inside the Kidspiration folder.

4 Select the symbol category under which you want the library to
appear (for example, “Custom”), and then open the folder.

5 Copy the symbol library file from the diskette or network
server to the category folder.

Tip:
You can share Inspiration symbol libraries with Kidspiration.
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Using Kidspiration projects with other programs

Use a Kidspiration project with another program

You can save Kidspiration projects in a variety of file formats that
can be opened in other programs. This process is called
“exporting.” To find out which file format you can use with another
program, refer to the documentation that came with the program.

In Picture view, you can export a diagram to the
following file formats:

♦  BMP (Windows)—Saves a diagram in the standard Microsoft®
Windows graphic bitmap format (BMP).

♦  PICT (Macintosh)—Saves a diagram as a PICT or PICT2 file
that can be opened in graphics, presentation, and page layout
applications.

♦  GIF—Saves a diagram as a 256-color graphic that can be
opened in graphics, presentation, and page layout programs or
Web pages.

♦  JPEG—Saves the diagram as a graphic that can be opened in
graphics, presentation, and page layout programs or Web
pages.

♦  HTML—Saves a diagram as an HTML document, which can
be viewed on the World Wide Web. The diagram shrinks so
that it fits on a 640-pixel-wide screen. The height is adjusted
proportionally. Any hyperlinks in the diagram are included as
hyperlinks in the HTML document. This export makes two
files: an HTM file and GIF file. Both files need to remain
together to view the HTML file in a browser.
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In Writing view, you can export a project to the following
file formats:

♦  Plain Text—Saves a writing project as an unformatted text-
only document with outline levels.

♦  AppleWorks (RTF)—Saves a writing project as a formatted
document that can be opened in AppleWorks.

♦  Microsoft Word (RTF)—Saves a writing project as a formatted
document that can be opened in Microsoft Word 4.0 and
higher. When you open the document in Word, a dialog box
may appear, asking if you want to convert the RTF data. Click
Yes to open the formatted document.

♦  HTML—Saves a writing project as a one-page HTML
document, which can be opened by a Web browser. When you
save a writing project as a one-page HTML document, the First
Idea becomes the title of the HTML document. The title of the
page appears in large type at the top of the page. Ideas, sub-
ideas and details appear as the body of the document. At the
end of the page, a “Back to Top” link appears. When you click
“Back to Top,” you return to the top of the page. Any
hyperlinks in the writing project are retained in the HTML
document.
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Export a project

1 Open the project.

2 On the File menu, click Export.

3 Select the file format to which you want to convert the
diagram, and then click Save.

4 Select the folder where you want to save the file.

5 Type a name for the file.

Kidspiration automatically uses your First Idea as the name and
assigns the appropriate file extension, but you can change it if
you want.

6 Click Save.

When you export a diagram to HTML, the export makes two
files: an HTM file and GIF file. Both files need to remain
together to view the HTML file in a browser.

Save a diagram as an HTML document

You can save a diagram as a one-page HTML document, which can
be opened by a Web browser.

To save a diagram as an HTML document:

1 Open the diagram.

2 On the File menu, click Export.

3 Select HTML, and then click Save.

4 Open the folder where you want to save the document.

5 Type a name for the document.

6 Click Save.

When you export a project to HTML in Picture view, the
export creates two files: an HTM file and a GIF file. These files
must be kept in the same folder. Double-click the HTM file to
view the HTML document.
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Save a writing project as an HTML document

You can save a project in Writing view as a one-page HTML
document, which can be opened by a Web browser.

When you save a writing project as a one-page HTML document,
the First Idea becomes the title of the HTML document. The title of
the page appears in large type at the top of the page. Ideas,
supporting ideas, and notes appear as the body of the document. At
the end of the page, a “Back to Top” link appears. When you click
“Back to Top,” you return to the top of the page. Any hyperlinks in
the outline are retained in the HTML document.

To save a writing project as an HTML document:

1 Open the writing project.

2 On the File menu, click Export.

3 Select HTML, and then click Save.

4 Select the folder where you want to save the document.

5 Type a name for the document.

Kidspiration automatically uses the First Idea as the name and
assigns the appropriate file extension. You can change the
name of the file if you want.

6 Click Save.
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Inspiration Software, Inc. License
Agreement

IMPORTANT   PLEASE READ THIS LICENSE AGREEMENT
CAREFULLY BEFORE OPENING THE SOFTWARE PACKAGE:
By opening this Software package (package containing the CD), you agree to be
bound by the terms and conditions of this Agreement. If you do not agree with
these terms, promptly return the unopened Software package, along with the rest
of the package, to the place of purchase for a full refund.

This is a legal agreement between you, the end user, and Inspiration Software, Inc.
The enclosed computer program (“Software”) is licensed, not sold, to you by
Inspiration Software, Inc. for use under the terms of this license.

GRANT OF LICENSE: Inspiration Software, Inc. grants you the following
rights to the Software:

Single installation: You may install and use the Software on the temporary
memory or hard drive or other storage device of any single computer used by one
person at a time. You must license (purchase) an additional copy of the Software
for each additional computer on which you want to use it. You must also license
(purchase) additional copies of the software if the single computer is being used in
a server-based computing environment, which allows multiple, concurrent users to
run a single server.

Multiple licenses: If you have multiple Licenses of the Software, then at any time
you may have as many computers with the Software installed as you have
Licenses. You must license (purchase) an additional copy of the Software for each
additional computer on which you want to use it.

Ownership: You admit and agree to the validity and enforceability in all respects
of any copyright of Inspiration Software, Inc. You agree that you will not
participate in any attack on the validity or enforceability of any of the present
copyrights, or potential future copyrights of Inspiration Software, Inc. whether in
court, the United States Copyright Office, or elsewhere except as may be required
in response to a subpoena. All rights to the Software (including but not limited to
any images, photographs, animations, video, audio, music, text, examples,
templates, symbols and software modules incorporated into the Software) are
owned or licensed by Inspiration Software, Inc. and are protected by the United
States and International copyright laws and International trade provisions.
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OTHER RESTRICTIONS: You may not:

a) Reverse-engineer, disassemble, decompile, modify or create derivative works
of this software.

b) Sublicense, rent, loan or lease any portion of the Software or accompanying
materials.

c) Use the backup or archival copies of the Software (or allow someone else to
use such copies) for any purpose other than backup.

You may transfer the Software and the accompanying written materials to a
recipient provided you retain no copies and the recipient agrees to the terms of this
Agreement.

LIMITED WARRANTY: Inspiration Software, Inc. warrants that the media on
which the Software is recorded will be free of defects in materials and
workmanship under normal use for 90 days after the date of original purchase. If a
defect occurs during the 90-day period, you may return the media (disks or CD) to
Inspiration Software, Inc. for free replacement. Inspiration Software, Inc. will
replace the media, provided that you have previously returned the product
registration card accompanying the Software to Inspiration Software, Inc. Any
replacement Software will be warranted for the remainder of the original warranty
period or 30 days, whichever is greater. These remedies are not available outside
of the United States of America.

Inspiration Software, Inc. disclaims all other warranties, either express or implied,
including but not limited to implied warranties of merchantability and fitness for a
particular purpose, with respect to the product. This limited warranty gives you
certain legal rights. You may have others, which vary from state to state. In no
event will Inspiration Software, Inc. be liable to you for damages, whether based
on contract, tort, warranty or other legal or equitable grounds, including any loss
of profits, cost savings or other incidental or consequential damages arising out of
your use or inability to use the Software, even if Inspiration Software, Inc. or an
authorized representative of Inspiration Software, Inc. has been advised of the
possibility of such damage. Inspiration Software, Inc. does not warranty that the
Software will meet your requirements or that the operation of the Software will be
uninterrupted or error-free.

GENERAL: This License will be construed under the laws of Oregon, except for
that body of law dealing with conflicts of law. If there is any dispute under the
present agreement, you consent to the jurisdiction and venue of all state and
federal courts of Oregon. If any provision of this License shall be held by a court
of competent jurisdiction to be contrary to law, that provision will be enforced to
the maximum extent permissible, and the remaining provisions of this License will
remain in full force and effect. If you are a U.S. Government user, then the
Software is provided with “RESTRICTED RIGHTS” as set forth in the sub
paragraphs c(1) and (2) of the Commercial Computer Software-Restricted Rights
clause at FAR 52.277-19 or subparagraph c(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.277-7013, as applicable.
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Index

About Kidspiration, 7
Acrobat Reader, 8
activities, 50, 101, 102, 103, 104

creating, 102
modifying, 104
opening, 50, 102
sharing with other computers, 104

adding details, 35, 74
adding hyperlinks, 105
adding hyperlinks to selected text, 105
adding ideas, 33, 74
adding links, 61
adding name to a project, 47, 98
adding notes, 35, 74
adding page numbers, 97
adding SuperGrouper categories, 40, 64
adding symbols, 57, 58, 65

Add Symbol tool, 24, 58
point and type, 57
SuperGrouper categories, 43, 65
Symbol palette, 25, 57, 58, 65

animated symbols, 109
Application Options, 108, 109, 110, 111, 112

Animated Symbols, 109
Desktop, 110
Listen tool, 108
Picture-to-Topic, 112
Sound Recording, 109
Spelling checker, 110
Talking Interface, 108
URL Hyperlink Auto-detection, 111
URL Hyperlinks, 111

arrowhead style, 86
audio, 93, 94, 95, 96, 108, 109

disabling sound recording, 109
disabling the Listen tool, 108
disabling the Talking Interface, 108
erasing recorded sounds, 96

playing recorded sounds, 29, 96
reading program menus and buttons, 93
reading text in symbols and ideas, 28, 94
recording sounds, 28, 95
recording words, 28, 95

BMP files, 122
bold formatting, 80
categories

symbol libraries, 119
categorizing ideas, 39, 63
categorizing symbols, 63
changing arrowhead style, 86
changing colors, 43, 81, 83, 86, 87

background, 87
lined paper, 87
links, 86
SuperGrouper categories, 43, 83
symbols, 30, 83
text, 81

changing font, 35, 79
changing level of idea, 75
changing line thickness, 85
changing order of symbols, 118
changing symbol text, 60
changing symbols, 59
changing text color, 35
changing text size, 35
checking spelling, 91
Clear tool, 29
closing Kidspiration, 13
closing projects, 38, 48
colors, 43, 81, 83, 86

links, 86
reverting to original symbol colors, 83
SuperGrouper categories, 43, 83
symbols, 30, 83
text, 81

connecting symbols, 27, 61
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copying and pasting, 69, 76, 90, 116
graphics into symbol libraries, 116
ideas, 76
symbols, 69
text, 90

copying and pasting graphics into symbol
libraries, 116

copying symbol libraries, 120
copying symbols, 117
creating activities, 102
creating diagrams, 21, 55, 56
creating HTML documents, 124, 125

Picture view, 124
Writing view, 125

creating symbol categories, 119
creating symbol libraries, 120
cutting and pasting, 68, 77, 90

ideas, 77
symbols, 68
text, 90

dashed links, 85
default look, 107

projects, 107
sharing with other computers, 107

deleting hyperlinks, 106
deleting ideas, 76
deleting Kidspiration, 12
deleting links, 68
deleting part of a diagram, 29
deleting symbols, 67, 68
deleting symbols from libraries, 118
Desktop, 110
details

adding to ideas, 74
diagrams, 21, 23, 55, 67, 124

creating, 21, 55
examples, 56
exporting, 124
saving in another file format, 124
selecting everything, 67
starting, 23

dictionary, 92
disabling

animated symbols, 109
Picture-to-Topic option, 112

sound recording, 109
spelling checker, 110
Talking Interface, 108
Teacher menu, 101
URL Hyperlink Auto-detection, 111
URL hyperlinks, 111

documents, 23, 30, 38, 40, 48, 49, 51, 87, 97,
107, 122
closing, 38, 48
default look, 107
exporting, 122
opening, 49, 51
printing, 48, 97
saving, 23, 30, 40, 51
saving in another file format, 122

editing text, 89, 90
editing user dictionary, 92
enabling Teacher menu, 101
erasing recorded sounds, 96
examples, 56, 72
exiting Kidspiration, 13
exporting projects, 122, 124
files

opening, 50, 51, 52, 53, 102
font, 35, 79
formatting Internet addresses, 111
formatting links, 85, 86

color, 86
dashed, 85
thickness, 85

formatting page, 36, 87
background color, 87
lined paper colors, 87
prefix style, 36, 87

formatting symbols, 42, 82, 83, 84
color, 83
line thickness, 82
size, 42, 84

formatting text, 35, 79, 80, 81
bold, 80
color, 81
font, 35, 79
italics, 80
text size, 35, 80
underline, 81
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formatting toolbars, 17, 20
GIF files, 122
Go to Pictures tool, 37, 47, 77
Go to Writing tool, 31, 45, 70
graphic file formats, 122
graphics, 69, 70, 114, 115, 116

copying and pasting into diagrams, 70
dragging and dropping into diagrams, 69
dragging and dropping into symbol

libraries, 115
inserting into diagrams, 69

hardware and software requirements, 9
hiding lined paper in Writing view, 88
HTML documents, 122, 124, 125

creating in Picture view, 124
creating in Writing view, 125

hyperlinks, 105, 106, 111
adding, 105
adding to selected text, 105
automatic formatting, 111
deleting, 106
disabling, 111

ideas, 33, 34, 35, 74, 75, 76, 77
adding, 33
adding details, 35, 74
categorizing, 39
copying and pasting, 76
cutting and pasting, 77
deleting, 76
moving, 34, 75
selecting, 75
selecting all, 75
selecting multiple, 75

importing files, 52
importing graphics into diagrams, 69
Inspiration files, 53
installing Kidspiration, 10
Internet hyperlinks, 105, 106, 111

adding, 105
adding to selected text, 105
automatic formatting, 111
deleting, 106
disabling, 111

italic formatting, 80
JPEG files, 122

Kidspiration, 10, 12
installing, 10
registering, 12

landscape page orientation, 99
learning activities, 50, 102
line thickness, 82, 85
lined paper, 88
lined paper colors, 87
linking symbols, 27, 61
links, 62, 63, 68, 85, 86

adding text, 62
arrowhead style, 86
color, 86
dashed, 85
deleting, 68
formatting, 85
line thickness, 85
moving, 62
moving text, 63

Listen tool, 28, 94, 108
disabling, 108
using, 28, 94

listening to ideas in projects, 28, 93, 94
magnifying the view, 70
modifying activities, 103
moving ideas, 34, 75
moving links, 62
moving symbols, 26, 58
moving symbols in a library, 118
name

printing at top of page, 47, 98
opening activities, 50, 102
opening documents, 51
opening files created in other programs, 52
opening Inspiration files, 53
opening projects, 51
page numbers

printing, 97
page orientation, 99
paper size, 98
PICT files, 122
Picture view, 13, 15, 37, 47, 77

overview, 13
switching to, 77
toolbars, 15
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Picture-to-Topic option, 32, 73, 112
playing recorded sounds, 29
portrait page orientation, 99
Preferences, 108, 109, 110, 111, 112

Animated Symbols, 109
Desktop, 110
Picture-to-Topic, 112
Sound Recording, 109
Spelling checker, 110
Talking Interface, 108
URL Hyperlink Auto-detection, 111
URL Hyperlinks, 111

prefix style, 36, 87
printing options, 97, 98, 99

page numbers, 97
page orientation, 99
paper size, 98
student name, 98

printing projects, 48, 97
projects, 30, 40, 49, 51, 87, 97, 107, 122

closing, 38, 48
default look, 107
exporting, 122
opening, 51
printing, 48, 97
saving, 23, 30, 40, 51
starting, 23, 39, 49
using with other programs, 122

reading text in menus and buttons, 93, 108
recording sounds, 28, 93, 95, 96

disabling sound recording, 109
recording words, 28, 95
reducing the view, 70
registering Kidspiration, 12
removing hyperlinks, 106
removing ideas, 76
removing Kidspiration, 12
removing symbols, 65

SuperGrouper categories, 45, 65
removing symbols and links, 68
renaming a project, 52
reverting to original symbol colors, 83
saving diagrams as HTML documents, 124
saving projects, 23, 30, 40, 51, 52, 122

available file formats, 122

under a new name, 52
saving writing projects as HTML documents,

125
selecting all ideas, 75
selecting everything on a diagram, 67
selecting ideas, 75
selecting multiple ideas, 75
selecting multiple symbols, 66
selecting part of a diagram, 67
selecting symbols, 66
selecting symbols and links, 66
selecting words, 90
sharing activities, 104
sharing default look with other computers,

107
sharing symbol libaries, 121
showing lined paper in Writing view, 88
showing the Desktop, 110
size

symbol, 83, 84
software and hardware requirements, 9
sounds, 28, 95, 96

erasing, 96
playing, 29, 96
recording, 28, 95

spelling checker, 92, 110
starting Kidspiration, 13, 22
starting projects, 23, 39, 49
SuperGrouper categories, 42, 63, 64, 65, 84

adding, 40, 64
adding symbols, 43, 65
adding title, 41, 64
colors, 43, 83
removing symbols, 45, 65
resizing, 42, 84
Writing view, 45

SuperGrouper tool, 39, 63
Support, 8
switching to Picture view, 37, 47, 77
switching to Writing view, 31, 45, 70
symbol categories, 119
symbol libraries, 112, 114, 116, 118, 120, 121

changing order of symbols, 118
copying and pasting graphics, 116
creating, 120
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deleting symbols, 118
inserting graphics files, 114
sharing, 121

Symbol palette, 16, 57
symbol text

changing, 60
symbol text in Writing view, 73
symbols, 59, 60, 61, 63, 65, 66, 67, 68, 69, 82,

83, 84, 113, 117, 118
adding, 24, 25
adding text, 59
adding to SuperGrouper categories, 65
categorizing, 63
changing, 59
changing text, 60
colors, 30, 83
copying and pasting, 69
copying from library to library, 117
cutting and pasting, 68
deleting, 67, 68
deleting from symbol libraries, 118
formatting, 82
inserting into symbol libraries, 113
line thickness, 82
linking, 27, 61
moving, 26
removing SuperGrouper categories, 45
selecting, 66
size, 42, 84

system requirements, 9
Teacher menu, 101

enabling, 101
Technical Support, 8
text, 35, 59, 62, 63, 79, 80, 81, 89, 90

adding to links, 62
adding to symbols, 59
bold formatting, 80
changing, 60
color, 35, 81
copying and pasting, 90
cutting and pasting, 90
editing in idea, 89
editing in symbol, 89
font, 35, 79
formatting, 79

italic formatting, 80
moving on a link, 63
size, 35, 80
underlining, 81

text size, 35, 80
toolbars, 15, 17, 19, 20

Picture view, 15
Writing view, 19

turning off animation, 109
turning off Picture-to-Topic, 112
turning off sound recording, 109
turning off spelling checker, 110
turning off Talking Interface, 108
turning off Teacher menu, 101
turning off URL Hyperlink Auto-detection,

111
turning off URL hyperlinks, 111
tutorial, 21
underlining text, 81
Undo tool, 29, 69
undoing changes, 29, 69
URL Hyperlink Auto-detection, 111
URL hyperlinks, 105, 106, 111

adding to selected text, 105
automatic formatting, 111
deleting, 106
disabling, 111

voice, 93, 94
choosing, 94
disabling Talking Interface, 108

Web pages, 124, 125
creating in Picture view, 124
creating in Writing view, 125

words
recording, 28

writing projects
exporting, 124

writing projects
examples, 72
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Writing view, 18, 19, 31, 70, 71, 73
overview, 18
Picture-to-Topic option, 73
switching to, 70

toolbars, 19
working with ideas, 71

X in Color tool, 83
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